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Welcome
Thank you for purchasing the DaySavor Screen-A-Day -Calendar.    KaizenWorks Publishing Inc. is 
dedicated to providing you with useful quality software products.

DaySavor is a powerful engine for displaying inspirational text and graphics.    DaySavor includes tools 
that allow    you to...

· Display pictures stored in a variety of formats

· Build your own library of pictures

· Build your own library of inspirational Messages

· Print pictures and/or text to printers, fax, or    e-mail compatible text files

· Choose your own fonts and colors for the Messages

· Display when Windows starts

· Display at a set time of day

· Display at set intervals throughout the day

· Display as "Mini-Note" that that is visible while you work on other applications

· Play sound during display

· Select Favorite text and/or picture

· Search a Message file by key word

· Bookmark Messages for later reference

· Print or export your list of bookmarked Messages

· Use DaySavor as a screen saver

The "How Do I" format of this help file is designed to allow    you to easily find ways to accomplish tasks 
with the DaySavor program.    The "Running The Program" section will discuss the layout and function of
each of the forms in the program. 

Please take the time to read the instruction manual.    It will save you time and make using the 
DaySavor program more enjoyable.



Installation
We have done our best to make installing and setting up DaySavor is a simple process.    Accepting the 
default settings during the installation process will properly configure the program and should ensure a 
trouble free installation. You may easily change settings later.

1. Insert the disk in you computer's 3.5" floppy drive.

2. From the run menu type A:setup or B:setup depending on which drive the disk is in.

3. The installation program will initialize and display a "Welcome" message.    Click the OK button to 
continue.

4. The installation program will search your hard drive for a previous copy of the DaySavor program.
If it finds a previous copy it will make the default directory the same as the previous versions. 

5. A dialog box will be displayed allowing you to select where you would like to install the DaySavor 
program to.    Unless you are an advanced computer user it is best to accept the default directory. 
Click the OK button to continue.

6. The installation program will now copy all the needed files to your computer.

7. The installation program will then ask if you would like it create icons for DaySavor.    Click Yes to 
continue.

8. You will then be asked to select a program group for the icons.    Again it is best to accept the 
default by clicking on the OK button.

9. The installation program will now ask if you would like the DaySavor program to automatically 
load whenever you start Windows.    It is recommended that you select Yes to continue.    You can
always remove the DaySavor icon from your Startup Group later if you decide to.

10. You will now be asked if you would like the DaySavor screen saver to be your active screen 
saver.    Select Yes to make this change, No to keep your old screen saver.

11. Finally a message will be displayed advising you that the installation has been completed 
successfully.

12. Depending on your computer's configuration you will be advised to restart Windows so that all 
updates can be completed.    Accepting this choice will automatically shut down then restart 
Windows.



Uninstalling
DaySavor comes with a full featured uninstall utility.    Should you decide to remove DaySavor from your 
system simply click on the Uninstall icon in your DaySavor program group.

The safest way to uninstall is to accept the automatic uninstall.    This will safely remove the program.    
Should you want more control selecting Custom will allow you to manage all the details of the uninstall 
process.    Follow the prompts to complete the uninstall.



General
The DaySavor program is easy to learn and use.    The interface of the program consists of individual 
forms each of which has a particular function.    The forms either display content, allow the user to set 
program options or work with the program's content.    

Each of the program's forms are individually discussed in the manual.



The Full Screen Display
The Full Screen Display will probably not look like a traditional window to you.    For aesthetic reasons it 
has been designed to cover the whole screen without borders.    No buttons or controls appear on the 
form.    When active it displays only a picture and a Message.

There are many functions you can access from this form.    These functions are all accessed through a 
popup menu.    To activate the popup menu you can press any key or click your right mouse button.

Take some time to try each of the functions in the popup menu.    These will be some of your most used 
features.    They include

· Printing pictures and text.

· Exporting to other programs.

· Setting display font attributes.

· Accessing other forms

· Browsing pictures and Messages.

· Access the Mini-Note form

· Access the Options form

· Access the Button Bar

· Access    Online Help

The Full Screen Display is automatically activated according to the program's configuration options or 
can be manually activated from the Button Bar.



The Mini-Note
The Mini-Note Form allows    you    to display the daily Message while working with other programs.    It 
will be displayed "on top" of all other applications and so will always be visible.    

For aesthetic purposes the Mini-Note has been designed so no buttons or controls are visible.    The 
functions available to the Mini-Note Form are accessed through a popup menu.    The popup menu can 
be activated by clicking the right mouse button.    The available functions allow    you to

· Set font attributes.

· Set the form's background color

· Access the Button Bar.

· Disable the program

The Mini-Note can be positioned and sized like any other standard window.    It will remember it's last size
and position.

The Mini-Note can be activated from the Button Bar or the Full Screen Display.



The Button Bar
The Button Bar contains four buttons that allow    you to quickly navigate through the program's features 
and options.    These buttons allow you to

· Activate the Full Screen Display.

· Activate the Mini-Note

· Activate the Options Form

· Disable the program

The Button Bar can be positioned like any other window but it cannot be sized.

Most of the program's other forms automatically return to the Button Bar when closed.



The Options Form
The Options Form is used to set the programs configuration.    The form contains three pages.    To move
from page to page click on the desired page with the mouse or press the an arrow key.

· The General Page allows you to set the following options

Display At StartUp-    Selecting this option will cause the Full Screen Display to be shown each 
time the DaySavor program is started.    This should not be confused with activating the 
program each time Window's is started.    That requires that both the At Startup option is 
checked and that a DaySavor icon is in the Program Manager's StartUp Group.

Enable Sound-    If your computer is multi-media capable checking this option will cause a WAV 
file to be played whenever the Full Screen Display is shown.

At A Set Time-    This option allows you to set a specific time for the Full Screen Display to be 
shown.    

At A Set Interval- This option will cause the Full Screen Display to be shown every so many 
hours.    The user is able to set the interval.

Timed Display-    Selecting this option will cause the Full Screen Display to automatically close 
after a set number of minutes.

· The Libraries Page allows you to set the following options.

Select the active Message file

Select the active picture directory

Select the active sound file

Activate the Message Editor

Test the sound file

· The Favorites Page allows you to

Select and limit the display to a favorite Message

Select and limit the display to a favorite picture

Please note that in order to make any changes made on the Options Form permanent you must click the
Save Button when done.    Should you wish to close the Options Form without saving your changes, 
click the Cancel Button.    Your original options will be reset.



The Message Editor Form
The Message Editor Form is a powerful tool allowing    you    create and edit your own libraries of 
Messages.    The possibilities are virtually limitless!

The Message Editor is accessed from the Libraries Page of the Options Form by clicking the View 
Messages Button.    When closed it will return you to the Options Form.

The Message Editor Form consists of    the following components

· A menu bar allowing access to functions

· A speedbar containing buttons to access functions

· A grid for browsing and editing a Message file

Use the Message Editor to perform the following tasks

· Create a new Message file

· Edit an existing Message file

· A reference of    Messages

· Create a personal list

· Export Messages to other programs

· Choose a favorite Message

See the How do I... section for detailed instructions on how to accomplish these tasks.



Add A Picture
Adding a picture is very simple.      The DaySavor program will automatically include all pictures in the 
currently selected picture directory.    You can find out the current picture directory by looking on the 
Library page of the Options form.    Just use File Manager or Explorer to copy the new picture file into the 
current picture directory and you are done.

The program will accept pictures stored in any of the following file formats.

· *.bmp

· *.tif

· *.gif

· *.jpg

· *.pcx

· *.png

· *.wmf



Delete A Picture
Deleting a picture is as simple as removing the picture file from the current picture directory.    The current 
picture directory can be found on the library page of the Options Form.

Use File manager or Explorer to move or delete the file from the directory.



Set Display Fonts
You can set the display fonts from the popup menu on the Full Screen Display.    To activate the popup 
menu simply press any key or click on the picture with the right mouse button.      

· Click on the menu item Fonts, a sub-menu will appear

· Click either First Letter or Message depending on which font you want to set.

· A standard font selection dialog box will appear.    Select the font, color, style and size you want

· Click the OK button and your changes will be applied to the display.

Note: The program has been designed to display the first letter of the Message at a larger size than the 
rest of the Message.    Although you are free to choose any font attributes you like, you will get better 
results using a large font size for the first letter.    The font used for displaying the date is the same as for 
the first letter but is reduced in size.



Print Current Picture and/or Message
You can print the currently displayed picture and/or Message from the Full Screen Display's popup 
menu.    To activate the popup menu press any key or click the right mouse button.    

You can choose to print the picture and Message together by selecting the menu item Print Graphic.    
You can print the Message only by choosing the menu item Print Message.    In either case the Add 
Personal Message Form will appear.    Use this form to type in any note or comment you choose.    You 
may also leave it blank.    The font for displaying and printing the personal message can be selected by 
clicking the Font button.    You can also choose to include the current date by checking the Include Date 
Box.

To start printing click the Print Button.    A standard print setup dialog box will appear allowing you to 
select any printer you computer has access to.    This includes any FAX programs on your computer.    
After selecting your printer click the OK button to print.



Save Current Message To A Text File
You can save the currently displayed Message to a standard text file suitable for importing to most other 
programs and for e-mail.    You can do this from the popup menu on the main Full Screen Display.    To 
access the popup menu press any key or click the right mouse button.

The current Message will appear in the add a Personal Message Form.    Here you can edit the Message
and add any message or notes you choose.    Text files are saved without    font formatting so any font 
adjustments you make will affect the display only.    When done with your editing click the Save Button.    
A standard Save As dialog box will appear allowing you to choose a file name and where on the disk you 
want to save it.



Copy Current Message To Clipboard
You can copy the currently displayed Message to Window's clipboard from the Full Screen Display's 
popup    menu.    To access the popup menu press any key or click the right mouse button.

On the menu choose Copy.    The current Message will be copied to the clipboard and is ready to be 
imported to any application that supports the paste function.



Browse Pictures and Messages
You can browse the current pictures and Messages directly from the Full Screen Display.    To do this 
activate the popup menu by pressing any key or clicking the right mouse button.    

You can move forward through the library by choosing Advance from the menu and then either Picture 
or Message.

You can move backward through the library by choosing Back from the menu then either Picture or 
Message from the sub-menu.

The display will update with the new selection automatically.



Show and Configure Mini-Note
The Mini-Note Form can be activated from either the Full Screen Display or the Button Bar.

To activate Mini-Note from the Button Bar , click the Mini-Note Button.

To activate Mini-Note from the Full Screen Display, activate the popup menu by clicking with the right 
mouse button or pressing any key.

The Mini-Note will remain visible "on top" of all other forms on your screen.    You may temporarily 
minimize it by clicking the down arrow in the upper left corner.    You may size or position it as you would 
any other window.    The form will remember it's last size and position.

You may set the font attributes for the form through it's popup menu.    Activate the popup menu by 
clicking with the right mouse button.    Select the menu choice Fonts and use the standard dialog box to 
configure the font.

You can also choose the form's background color through the popup menu by choosing the Back Color 
menu item.    Choose the color you want using the standard dialog box.



Access the Options Form
The Options Form can be access from either the Button Bar or the Full Screen Display.

From the Full Screen Display activate the popup menu by pressing any key or clicking the right mouse 
button.    Select Options from the menu items.

From the Button Bar click the Options Button.



Access The Button Bar
The Button Bar can be accessed from the Full Screen Display, the Options Form or the Mini-Note.

From the Full Screen Display, activate the popup menu by clicking with the right mouse button or 
pressing any key.    Select Close Display from the menu items.

From the Mini-Note, activate the popup menu by clicking the right mouse button.    Choose Close Mini-
Note from the menu items.

From the Options Form, choose either the Save or Cancel button at the bottom of the form.

If you have not selected the At StartUp option the Button Bar will not be shown when you first launch the
program.    Instead it will be shown as an icon on your desktop (Windows 3.x) or    your taskbar (Windows 
95).    In order to open the Button Bar just click on the icon.



Set Display Options
DaySavor allows you to choose when and how it will activate the Full Screen Display.      These choices 
are all made on the General Page of the Options Form.

· If you would like the display to activate each time you start the program, check the At StartUp 
box.    This can be in addition to other display times and is the default setting.    If you uncheck this
box but leave the DaySavor Icon in Window's StartUp group the program will load in an icon 
mode.    This is convenient if you want to manually display the program. It is required if you have 
set either At A Set Time or At A Set Interval options.

· If you would like the display to activate at a set time, on the General page of the Options Form 
click the At A Set Time Button.    This will cause an edit box to appear immediately to the 
button's right.    In this edit box enter the time you would like the display to happen.    Please enter 
all leading and trailing zeros and remember to include AM or PM. (example:08:30AM).    Note: this
will disable the At A Set Interval setting.

· If you would like the display to activate at intervals throughout the day, click the At A Set Interval 
Button.    This will cause an edit box to appear immediately to the button's right.    Please enter 
the interval between displays in hours.    The minimum acceptable interval is 1 hour and the 
maximum is 11 hours.    Remember to enter leading and trailing zeros.    Note: this will disable the 
At A Set Time setting.



Start Program Each Time You Start Windows
The installation program installs an icon in Window's StartUp group.    This loads the program into 
memory each time Windows is started.    This is the default setting for the program.    If you wish to disable
this feature remove the DaySavor icon from the StartUp Group.    To Enable this feature add DaySavor 
back into the StartUp group.



Enable Sound
DaySavor can play sound when activating the Full Screen Display.    To enable the sound feature go to 
the General Page of the Options Form.    Check the Enable Sound Box.

Please note that your computer must be equipped with    multi-media capabilities in order for this feature 
to function.



Change Sound File
DaySavor includes a sound file complimentary to the library's subject.    The program will play any sound 
file you have as long as it is in the *.wav format.    To select a new sound file...

· Click the Select Sound Button on the Libraries Page of the Options Form.

· A standard windows File Open dialog box will appear.    Use it to select any WAV file on your 
computer.

· Click OK to set this file as you sound file.

· You can test the sound by clicking the Test Button.

· Make sure the Enable Sound Box is checked on the General Page of the Options Form.



Select A Picture Directory
DaySavor includes a library of pictures complimentary to the subject of the program.    The pictures are 
normally installed to a sub directory of the DaySavor directory.    You can access pictures held in any 
directory on your computer.    To select a new directory...

· Click the Picture Directory Button on the Libraries Page of the Options Form.

· A standard File Select dialog box will appear.    Select a picture file from any directory on your 
computer.

· You Must select a picture in the desired directory.    To do this simply click on the name of any 
picture in the directory.

· Click the OK button.    The path to your new picture directory will be shown in the edit box on the 
Libraries Page.

· The program will now    look in this directory for pictures to be displayed.



Select Current Message File
DaySavor offers versions covering a variety of subject matter.    Each of these libraries operates using the 
same base engine.    You may wish to purchase different libraries or create your own.    In either case it is 
easy to switch the active Message file.

· From the Libraries Page of the Options Form, click the Select Message file Button.

· A standard File Select dialog box will appear.    Select the desired *.qot file.

· Click the OK button.

· The path to the selected Message file will be shown in the edit box on the Libraries Page.



Select A Favorite Picture
If you have a picture that you would like to always be the one displayed you can select it as your favorite 
picture.    You do this from the Favorites Page of the Options Form.

· First click the    Select Picture Button.

· A standard File Select dialog box will appear.

· Select a picture file and click the OK button.

· The selected picture will be shown in the Preview box and the full path to the picture will be 
shown in the edit box.

· Click the Show Favorite Only Check Box to limit the display to this picture.



Select A Favorite Message
If you would like a Message to always be the one displayed you may set it as the Favorite Message.    
There are two ways to do this.

From the Favorites Page of the Options Form.

· Type in the Message and Author in the corresponding edit boxes.

· Check the Show Favorite Only Check Box

From the Message Editor Form

· Select the row containing the desired Message in the grid.

· Click the Set As Favorite Button (light bulb icon) on the speed bar or use the Set As Favorite 
item in the Edit Menu.



View Current Message File Contents
The current Message file may be viewed using the Message Editor Form.    You access the Message 
Editor from the Libraries Page of the Options Form by clicking the View    Messages Button.    The 
current Message file will be opened and it's contents displayed in the Message Editor grid.



Edit Messages
You can edit any Message in a Message file using the Message Editor Form which is accessed by 
clicking the View    Messages Button on the Libraries Page of the Options form.    To edit a particular 
Message.

· Find the Message in the Message Editor grid and click on that row    to make it the current row.

· Click on the Edit Button on the speedbar or select the Edit item in the Edit menu.

· An edit dialog will appear.    Make changes as desired and click the OK button.

Any changes you have made will be reflected in the Editor's grid.    However they are not saved to the 
permanent disk file until you click the Save Button.    This gives you the opportunity to make multiple 
changes between saves.    If you have made a mistake and don't want to permanently save the changes 
just re-open the file without saving.



Delete A Message
You can delete a Message using the Message Editor Form which is accessed by clicking the View 
Messages Button on the Libraries Page of the Options Form.    To delete a Message

· Find the Message in the Message Editor's grid and click on that row to make it the current row.

· Click on the Delete Button on the speedbar or select the Delete item from the Edit menu

· Confirm or cancel the deletion when prompted.

Please note that the deletion will not be permanent until you save your changes to the disk.



Add A Message
You can add a Message to an existing Message file using the Message Editor Form which is accessed 
by clicking the View Messages Button on the Libraries Page of the Options form.    To add a Message

· Click the Add Button on the speedbar or select the Add item from the Edit menu.

· An Add dialog will appear.    Enter the Message you wish to add and click the OK button.

The new    Message will be added to the bottom of the Message Editor's grid.



Move A Message In The Grid
You can move a Message in the Message Editor's grid by dragging it to the desired position.    To drag a 
Message

· Using the left mouse button    click    the gray box at the left of the grid.    Hold the button down.

· With the left mouse button held down move the mouse pointer to the desired position and release
the button.

The Message will be moved to the new position.



Search Message File For A Keyword
The Message Editor allows you to search an opened Message file for a keyword or phrase.    To search 
the file

· Type the keyword or phrase in the Find Edit Box on the speedbar.

· Click the Up or Down Arrow Button.    The Message Editor will move to the first row that 
contains a match to the keyword you entered.

· Click the Arrow Button again to find the next match.



Open A Message File
When the Message Editor is displayed it automatically opens the currently selected Message file.    If you
wish to work with a different Message file you can open it and load it into the grid by

· Clicking the Open Button on the speedbar or selecting the Open item from the File menu.

· A standard file open dialog will appear .    Select the file you wish to view, click the OK button and 
the file will be loaded into the Message Editor.



Create A New Message File
When the Message Editor is displayed it automatically opens the currently selected Message file.    To 
create a new file

· Click the New Button on the speedbar or select New from the File menu.

· A new blank file will be created along with a blank grid.

· You may start adding Messages to the grid.

Please note: At this point the file has been created in memory only.    You must save the file to disk
in order access it latter.    To do this click the Save Button on the speedbar and use the standard 
file save dialog.



Bookmark A Message
You can attach a bookmark to as many Messages in a file as you like.    To bookmark a Message

· Select the row in the grid by clicking it with the left mouse button.

· Click the Toggle Bookmark Button on the speedbar or select the Mark/Unmark item from the 
Edit Menu.

· A small double arrow    will appear in the gray box on the left of the grid row    indicating that the 
row is marked.

· To ummark a row select it and click the Toggle Bookmark Button.

· You may also bookmark a message from the Full Screen Display.    Should you want to bookmark 
the currently displayed message click the BookMark item from the PopUp Menu.



Build A Personal List 
You can build a personal list of Messages that have special meaning for you or deal with a particular 
subject.    The first step in building a personal list is to browse the Message file and mark the Messages of
interest using the bookmark feature.

Once you have built the list you can make use of it in the following ways.

Print to printer or Fax

· Click the View    Button on the speedbar or select the View List item from the Edit menu

· The Personal List dialog box will appear.

· Click the Print Button and use the standard dialog box to print to the device of you choice.

Save to a text file for use in another program

· Click the View Button on the speedbar or select View List from the Edit menu.

· The Personal List Dialog box will appear.

· Click the Save Button and use the standard File Save dialog box to create and save the file.

Copy the list to the clipboard for use in other programs

· Click the View Button on the speedbar or select View List from the Edit menu.

· The Personal List Dialog box will appear

· Click the Copy Button. 



General
DaySavor includes a screen saver as part of the program.    It's functionality is similar to that of the main 
program except that it is activated by Windows like all other screen savers.    The installation offers to set 
DaySavor as your active screen saver.

Under Windows 95 you should set up the screen saver from the properties page of the desktop.    You can
access the properties page by clicking the desktop with your right mouse button and selecting properties 
from the PopUp Menu.



To Manually Set The Screen Saver
Windows 3.1

· Select the Control Panel icon from the Main Group of Program Manager

· In Control Panel select the Desktop icon.    This will show the Desktop configuration form

· In the screen saver drop down list select DAYSAVOR

Windows 95

· Click on you desktop with the right mouse button

· A popup menu will appear.    Select Properties.

· The desktop configuration form will appear.    Click on the screen saver page

· In the drop down list select DAYSAVOR.



To Configure The Screen Saver
The DaySavor screen saver allows you to select an active Message file and picture directory.    This can 
be a different set of files than the one currently active for the DaySavor program.    This means that you 
can run each program simultaneously but display different pictures and Messages.    

To configure the screen saver 

· Use Control Panel to open the Desktop configuration utility

· Make sure DAYSAVOR is the currently selected screen saver

· Click the Setup Button

· The DaySavor screen saver configuration    form will appear.

· Select a Message file by clicking the Message File Button

· Select a picture directory by clicking the Picture Directory Button

· Set the display fonts by clicking the appropriate Font Button

· If you would like the screen saver to display a new message each time the picture transitions 
check the Random Messages Box.

· If you would like the screensaver to change messages on a daily basis uncheck the Random 
Messages Box.

· Save by clicking the OK button or the Cancel button to restore the original settings



Glossary of Terms
Button Bar
Desktop
Dialog Box
Edit Box
Explorer
File Manager
Formats
Grid
Library
Menu
Minimize
Popup Menu
Message File
Sound File
Speedbar
Startup Group
Text File



Button Bar
A floating form containing buttons that respond to a mouse click.



Desktop
Area of the screen not occupied by an application window.



Dialog Box
A standard Windows form used for file selection, font selection, color selection etc.



Edit Box
a box that contains data the user can change.



Explorer
Windows 95 file management utiltiy



File Manager
Windows 3.1 file management utulity



Formats
DaySavor can read the following type of picture files, *.bmp; *.jpg; *.gif; *.wmf; *.tif; *.eps; *.pcx; *.png



Grid
A control that displays information in rows and columns.



Library
As used in this manual, library refers to a collection of picture files stored in a directory, or a collection of 
Messages stored in a DaySavor compatible file with the extension *.qot



Menu
A list allowing access to program commands.    Activated with the mouse or keyboard.



Minimize
Shrink a form to an icon state.



Popup Menu
A popup menu is a menu of choices that remains hidden until activated by the user.    The menu is 
normaly activated by clicking the right mouse button.



Message File
A file format used by the DaySavor program to store information.    Must have *.qot extension.



Sound File
a file containing sound in a digital format.    DaySavor can read *.wav files.



Speedbar
A bar normaly located near the top of a form that contains buttons used to access a program's functions.



Startup Group
A Program Manager Group that Windows maintains containing icons for programs that will automatically 
be loaded each time Windows is started.



Text File
A file format able to be read by many programs.    Useful for exchanging data and for e-mail.    




